
Chapter 3

Creating Structures
Learning Objectives

After completing this chapter, you will be able to:
• Add members
• Configure member settings
• Add stairs
• Add ladders
• Add railings
• Add footings
• Modify the structural members
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INTRODUCTION
In this chapter, you will learn to create a structural layout that is an integral part of an industrial 
plant. To create a structural layout, first you need to create a new drawing file under the Plant 3D 
Drawing node using the PROJECT MANAGER. The procedure to create a new drawing has 
been discussed in Chapter 2. In this chapter, the tools used to create a structural layout will be 
discussed. These tools are available in the 3D Piping workspace.

Note
If the file is opened in a workspace other than 3D Piping, you need to switch to this workspace. To do 
so, select the 3D Piping option from the Workspace drop-down list in the Quick Access Toolbar.

 

CREATING A GRID 
 Ribbon:	 Structure > Parts > Grid 

A grid helps you to place structural components at appropriate location. To create a 
grid, choose the Grid tool from the Parts panel in the Structure tab; the Create Grid 
dialog box will be displayed, as shown in Figure 3-1. 

Figure 3-1  The Create Grid dialog box

In this dialog box, enter the name of the grid in the Grid name edit box. Next, specify the type 
of coordinate system to be used to set the orientation of the grid. You can specify the coordinate 
system by selecting any one of the radio buttons available in the Coordinate system area. The 
WCS radio button is used to define the coordinate system of the grid using the world coordinate 
system. The UCS radio button is used to define a user coordinate system. If you select the 
3 points radio button, you will be prompted to specify the origin point. After specifying the 
origin point, you need to specify one point on the X-axis, one point on XY plane, and then 
one point on the Z-axis. These three points specify the directions of three axes in a grid. After 
specifying the coordinate system, enter values for the axis points in the Axis value edit box. 
You can use @ symbol in order to enter a value relative to the preceding value. You can also use 
the Pick point button adjacent to this edit box to directly specify the points in the workspace. 
Next, specify names of the axes in the Axis name (local X) edit box. Similarly, enter values for 
the row points in the Row value edit box. Also, enter the names of the row points in the Row 
name (local Y) edit box. Specify the platform value points (in Z-direction) and their names in 
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the Platform value and Platform name (local Z) edit boxes, respectively. Next, enter the font 
size in the Font Size edit box for the names displayed in the grid. Choose the Create button; a 
grid will be created in the model space, refer to Figure 3-2. 

Figure 3-2  A 3D grid created

Editing Grids
To edit a grid, invoke the Structure Edit tool from the Modify panel and select the grid; the 
Edit grid dialog box will be displayed. The options in this dialog box are similar to the options 
in the Create Grid dialog box. Set the parameters in this dialog box as required and choose the 
OK button; the grid will be modified accordingly.

SETTING THE REPRESENTATION OF THE STRUCTURAL 
MEMBER
You can set the representation of the structural members as required

Figure 3-3  The Line 
Model drop-down 

 
by using the tools available in the Line Model drop-down of the Parts 
panel, refer to Figure 3-3. The different representations that you can 
set for the structural members are discussed next.

The Line Model is the default representation set for the member. In 
this mode, the members are represented as lines along with a symbol, 
as shown in Figure 3-4. This makes it easier to select the insertion 
point of a new member. In the Symbol Model mode, the members are 
represented as symbols, as shown in Figure 3-5. In the Outline Model 
mode, the members are represented as structural outlines, as shown in 
Figure 3-6. The Shape Model mode gives a real time look to the member 
with fillets added to the structural outline, as shown in Figure 3-7.
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Figure 3-4  The member in the Line Model 
mode

Figure 3-5  The member in the Symbol 
Model mode

 

Figure 3-6  The member in the Outline 
Model mode

Figure 3-7  The member in the Shape 
Model mode

ADDING MEMBERS
In AutoCAD Plant 3D, a column or a beam is referred to as a structural member. A structural 
member can be placed in the plant 3D layout by specifying its start point and endpoint. Before 
adding a structural member, you need to specify the member settings such as shape, size, 
orientation, material standard, and so on. To add a member, choose the Member Settings tool 
from the Settings drop-down in the Parts panel of the Structure tab, refer to Figure 3-8; the 
Member Settings dialog box will be displayed, as shown in Figure 3-9.

Figure 3-8  The Settings drop-down
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Figure 3-9  The Member Settings dialog box

In this dialog box, select the required standard for the shape of a member from the Shape 
standard drop-down list. Next, select the shape type from the list box available in the Shape 
type area. You can search for a shape type using the search box available above the list box. After 
selecting the shape, you need to specify the size from the list box available in the Shape size 
area. You can search for a shape size using the search box available. Next, select the required 
material standard and material code from the respective drop-down lists. Specify the orientation 
angle using the Angle drop-down list. You can use the increment button available adjacent to 
this drop-down list to increase the angle by 90 degrees. Now, specify the justification of the 
member by selecting a point in the preview window. You can select the Flip about Y axis check 
box to flip the orientation about Y axis. Also, you can select the Align Y Axis with Z UCS check 
box to align the Y axis of the member with the Z UCS. After specifying all the parameters in 
the Member Settings dialog box, choose the OK button to set the specified member settings. 

Next, choose the Member tool from the Parts panel; you will be prompted to specify the 
start point of the structural member. You can do so either by clicking in the drawing area 
or entering its coordinates at the Command prompt. After specifying the start point, you 
will be prompted to specify the endpoint of the member. Specify the endpoint where you want 
to end the member. At this point, you may continue to specify the points or terminate member 
creation by pressing ESC. 
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Tip You can align the structural member with an already created line. To do so, enter L in 
the Command Bar; you will be prompted to select a line to align a member with. Select a line 
from the drawing area and then press ENTER; the member will be aligned to the selected line.

CREATING STAIRS
To create stairs, first you need to specify the settings. To do so, choose the Stair Settings tool from 
the Settings drop-down; the Stair Settings dialog box will be displayed, as shown in Figure 3-10. 
In this dialog box, you can specify the settings for creating stairs.

Figure 3-10  The Stair Settings dialog box

Specify the width of the stairs and the tread distance by entering desired values in the Stair 
Width (1) and Maximum Tread Distance (2) edit boxes, respectively. Next, you need to specify 
the step shape. To do so, click on the Browse button adjacent to the Step data field; the Select 
Step dialog box will be displayed. In this dialog box, select the required tread standard from 
the Tread standard list box; the tread shapes under the selected standard will be displayed in 
the Tread shape list box. Select the required shape type from the Tread shape list box and click 
OK; the Select Step dialog box will be closed. Next, you need to specify the stair shape. To do 
so, click on the Browse button adjacent to the Stair shape field; the Select Stair Shape dialog 
box will be displayed. The options in this dialog box are same as to that available in the Member 
settings dialog box. Specify the settings in this dialog box and choose the Select button to close 
this dialog box. Next, choose the OK button to close the Stair Settings dialog box.   

After specifying the settings for the stairs, choose the Stairs tool from the Parts panel;
you will be prompted to select the first point. Select the bottom point for the stairs; you 
will be prompted to select the next point, refer to Figure 3-11. Specify the top point of 
the stairs and press ENTER; the stairs will be created, as shown in Figure 3-12. 
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Figure 3-11  Selecting the start and 
end points of the stair

Figure 3-12  Stairs created from the selected 
points

Editing Stairs
To edit a stair, choose the Structure Edit tool and then select the stair to be edited; the Edit 
Stair dialog box will be displayed. Modify the settings and choose OK to close the dialog box. 
You can also edit a stair using grips. To do so, select the stair to be edited; grips will be displayed 
on it, refer to Figure 3-13. You can use the center grips to change the location or length of the 
stairs and the side grips to increase or decrease the stair width.

Figure 3-13  Stair with grips displayed 
on it

CREATING RAILINGS
To add railing to a stair, you need to specify parameters in the Railing Settings dialog box. 
To do so, choose the Railing Settings tool from the Settings drop-down; the Railing Settings 
dialog box will be displayed, as shown in Figure 3-14. 
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Figure 3-14  The Railing Settings dialog box 

To specify different geometric values or parameters for the railing, enter desired values in the 
edit boxes available in the Geometry area in the dialog box. Refer to the preview window in 
Figure 3-14 for these parameters. Next, specify the shape properties by clicking on the Browse 
button available adjacent to the corresponding rails. Select the Middle rail (continuous) check 
box to make the mid rail continuous. Choose the OK button to close the dialog box.

After defining the settings for the railing, choose the Railing tool from the Parts panel;  
you will be prompted to select the start point. Select the bottom point of a stair and then 
select the endpoint of the railing. You will notice that as soon as you specify the endpoint of the 
first railing, you will be prompted to select the next endpoint. Press ENTER to terminate the 
command.

You can also add a railing to the stairs or members by selecting them from the drawing area. 
To do so, choose the Railing tool and then enter Object at the Command prompt; you will be 
prompted to select a stair or a structural member for applying the railing. Select the stairs or 
a structural member from the drawing area; the railing will be added to the selected member. 
Figure 3-15 shows a railing added to the stairs and other structural members.
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Figure 3-15  Railing added to the stairs 
and other structural members

CREATING LADDERS
To create a ladder, first specify the settings for the ladder. To do so, invoke the Ladder Settings 
dialog box by choosing the Ladder Settings tool from the Settings drop-down. In the Ladder 
Settings dialog box, choose the Ladder tab to display its options, as shown in Figure 3-16. 

Figure 3-16  The Ladder Settings dialog box
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Ladder Tab
The Ladder tab has three areas: General, Geometry, and Shape, refer to Figure 3-16. In the 
General area, you can specify the ladder type and description using the Type drop-down list 
and the Description edit box, respectively. 

The options in the Shape area allow you to specify the settings for ladder shape and rung shape. 
To change the ladder shape settings, choose the Browse button adjacent to the Ladder Shape 
edit box; the Select Ladder Shape dialog box will be displayed. Modify the settings and choose 
the Select button to close the dialog box. Also, you can select the Switch X and Y axes check 
box to rotate the ladder shape by 90 degrees. Similarly, you can change the rung shape settings 
by invoking the Select Rung Shape dialog box. 

The Geometry area contains options to define the geometry of the ladder. The preview window 
explains the use of the options available in this area. 

Cage Tab
The Cage tab in the Ladder Settings dialog box contains the General and Geometry areas. You 
can see the preview of the ladder geometry in the preview area, refer to Figure 3-17.

Figure 3-17  The Cage tab of the Ladder Settings dialog box

In the General area, select the Draw cage check box to create a ladder with a cage. You can 
enter the description of the cage in the Description edit box. 
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The Geometry area contains options to define the geometry of the cage. The preview window 
explains the use of the options available in this area. After specifying all the values, choose OK; 
the Ladder Settings dialog box will be closed. 

After specifying the settings for the ladder, choose the Ladder tool from the Parts panel;  
you will be prompted to select the start point. Select the bottom point and then the top 
point as the endpoint of the ladder; you will be prompted to specify the directional distance. 
Move the cursor in the perpendicular direction and enter a distance at the Command prompt; 
a ladder will be created.

CREATING A PLATE/GRATE
 Ribbon:	 Structure > Parts > Plate 

To create a plate or a grate, choose the Plate tool from the Parts panel; the Create Plate/
Grate dialog box will be displayed, as shown in Figure 3-18. 

Figure 3-18  The Create Plate/Grate dialog box

Use the Type drop-down to specify whether you want to create a grate or a plate. Next, specify 
the material of the plate/grating by selecting the required material standard and material code 
from the respective drop-down lists. After specifying the material, select the plate/grating 
thickness from the Thickness drop-down list. If you have selected the Grating option from the 
Type drop-down list, you need to select the required hatch pattern and hatch scale of the grating 
from the Hatch Pattern and Hatch Scale drop-down lists, respectively. 

Next, you need to specify the justification of a grating or plate using the options in the 
Justification area. Now, select an option from the Shape area. The New rectangular option is 
used to create a rectangular shaped plate/grating. The New polyline option is used to specify 
the shape by drawing a closed sketch using the Polyline tool. The Existing polyline option is 
used to select an already existing polyline sketch to create the plate/grating.
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After specifying the options in the Create Plate/Grate dialog box, choose the Create button; 
a prompt will be displayed at Command prompt depending upon the option selected in the 
Shape area. For example, if you select the New rectangular option, you will be prompted to 
specify the first corner point of the plate. Specify the first corner and then the second corner 
to create a plate or a grating. 

 CREATING FOOTINGS
 Ribbon:	 Structure > Parts > Footing 

Footing is one of the important components in a structural model. The function of footing 
in an industrial project is to provide support to the entire structural layout. To create a 
footing, first define the settings for it. To do so, invoke the Footing Settings dialog box 

by choosing the Footing Settings tool from the Settings drop-down list; the Footing Settings 
dialog box will be displayed. The Footing Settings dialog box has two areas: Geometry and 
Material, and a preview window, as shown in Figure 3-19.  

Figure 3-19  The Footing Settings dialog box

The Geometry area contains options to define the geometry of the footing. The preview window 
displays different parameters of the Geometry area. 

The options in the Material area allow you to specify the material standard and code for the 
footing. After specifying all the values, choose OK; the Footing Settings dialog box will be closed. 

After specifying the settings, choose the Footing tool from the Parts panel and specify a point 
to insert the footing.

EDITING THE STRUCTURAL MEMBERS
In the design process, you may need to edit the structural member. Various editing operations 
are discussed next.
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Changing the Length of a Member
 Ribbon:	 Structure > Cutting > Lengthen Member 

You can change the length of a structural member. To do so, choose the Lengthen 
Member tool from the Cutting panel; you will be prompted to select a member and the 
following prompt sequence will be displayed at the Command prompt.

Command: PLANTSTEELLENGTHEN
Select a structural member or [Delta/Total]: Select a member or enter an option
The options in the Command prompt are discussed next.

Delta
This option allows you to enter a value of the length that is to be added to the existing length of 
a member. When you choose this option from the Command prompt, you will be prompted to 
specify a delta length. Enter a value and select a member; the length of the selected member will 
be changed. If you have specified a positive value, the length of the member will be increased. 
The length of the member will be decreased if you have entered a negative value.

Total
This option allows you to specify a value for the total length of a member. 

Restoring the Member to its Original Length
 Ribbon:	 Structure > Cutting > Restore Member 

To restore the member to its original length, choose the Restore Member tool from the 
Cutting panel; you will be prompted to select the member. Select the member to restore 
it to its original length; the selected member will be restored to its original length.

Cutting Member at Intersections
 Ribbon:	 Structure > Cutting > Cut Back Member 

When two structural members intersect, you can remove the unwanted portion at the 
intersection using the Cut Back Member tool. To do so, invoke this tool from the Cutting 

panel; you will be prompted to select the first member. Also, the cut Both and Gap options will 
be displayed at the Command prompt. The cut Both option is used to cut both the intersecting 
members. The Gap option is used to create a gap at the intersection point. Note that you need 
to specify the required gap value at the Command prompt. Next, select both the intersecting 
members; the unwanted portion will be removed. Figure 3-20 shows a cut created using the cut 
Both option. Figure 3-21 shows a cut created by specifying a gap distance.
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Figure 3-21  A cut created by specifying 
the gap value

Figure 3-20  A cut created using the cut 
Both option

Creating Miter Joints 
 Ribbon:	 Structure > Cutting > Miter Cut Member 

A miter joint is created at the corner of two structural members by beveling them at an 
angle of 45-degrees. To create a miter joint between two structural members, choose the 

Miter Cut Member tool from the Cutting panel; you will be prompted to select the first structural 
member. Also, the Align edges and Gap options will be displayed at the Command prompt. 
The Align edges option allows you to create a miter joint with the edges of both the members 
aligned, as shown in Figure 3-22. The Gap option is used to create a miter joint with a gap 
between the edges, as shown in Figure 3-23. After choosing the required option, select the two 
intersecting members; the miter joint will be created.

Figure 3-22  Miter joint with aligned edges Figure 3-23  Miter joint with a gap 

Trimming/Extending a Member
 Ribbon:	 Structure > Cutting > Trim Member/Extend Member 

You can trim or extend members upto a specified plane. To do so, choose the Trim Member tool 
from the Cutting panel; the Trim to Plane dialog box will be displayed, as shown in Figure 3-24. 
The options in this dialog box are discussed next. 

 
Intersection plane Area
The options in this area are used to specify the plane at which the member is to be trimmed. 
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Figure 3-24  The Trim to Plane dialog box
XY WCS
This radio button is selected by default. As a result, the XY plane of the World Coordinate 
System is selected as the cutting plane.

XY UCS
Select this radio button to specify XY plane of the User Coordinate System as the cutting 
plane.

Names UCS
Select this radio button to specify XY plane of the named User Coordinate System as the 
cutting plane. 

3 Points
Select this radio button to specify XY plane of new coordinate system created by specifying 
3 points.

2 Points
Select this radio button to create a cutting plane by drawing a line. The cutting plane is a 
vector of the line drawn.

Named UCS Display Box
This box displays the Named User Coordinate System. 

Choose the OK button after selecting the required option and select a member that is to be 
trimmed; the selected member will be trimmed using the defined plane. 

You can also extend a structural member. To do so, choose the Extend Member tool from the 
Cutting panel in the Structure tab; the Extend to Plane dialog box will be displayed. The 
options in this dialog box are same as in the Trim to Plane dialog box. Select an option from 
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the Intersection plane area to define the plane upto which the member should be extended, 
and then choose the OK button; the dialog box will be closed and you will be prompted to select 
a member to extend. Select a structural member from the drawing area; it will extend upto the 
specified plane. 

Exploding a Structure
 Ribbon:	 Structure > Modify > Structure Explode 

You can explode structural objects into individual elements. Note that you can only 
explode stairs, railings, or ladders. To explode an object, choose the Structure Explode 
tool from the Modify panel; you will be prompted to select a structural object. Select a 

stair, railing, or ladder; the selected object will be exploded into individual elements that can 
be modified individually. 

VISIBILITY OPTIONS
When you create a plant layout, whether it is large or small, you may need to toggle the visibility 
of various objects in the layout. You can do so by hiding the components at any stage. The 
method to toggle the visibility of an object is discussed next.

Hiding and Displaying Components
To hide a component placed in a plant layout, select the component from the graphics area and 
choose the Hide Selected tool from the Visibility panel in the Structure tab; the display of the 
component will be turned off. To hide all other components except the selected component, 
choose the Hide Others tool from the Visibility panel. On doing so, the selected component 
will be displayed while all other components will be hidden.
 
To show all the hidden components, choose the Show All button; all hidden the components 
will be displayed again in the layout.

EXCHANGING DATA WITH OTHER APPLICATIONS   
 Ribbon:	 Structure > Export > Advance Steel XML Export  

The Advance Steel XML Export tool allows the exchange of steel structure data 
between two applications. To create an Advance Steel XML report, choose the Advance 
Steel XML Export tool from the Export panel; the Advance Steel XML Export dialog 

box will be displayed, as shown in Figure 3-25. Specify the path for the output file by using the 
Browse button available at the right side of the Output file edit box in this dialog box. 
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Figure 3-25  The Advance Steel XML Export 
dialog box

The Select Objects button in the Objects area is used to select objects from the workspace. The 
selection status will be displayed in the Objects area. After selecting the objects, choose the 
Export button to export the structure to .smlx format. 

TUTORIALS
Tutorial 1

In this tutorial, you will open the CADCIM project created in Chapter 2 and then create a new 
AutoCAD Plant 3D file. In this file, you will create a pipe rack, as shown in Figure 3-26. You need 
to use W10 x 12 structural members to create this pipe rack. The dimensions for the model are 
given in Figure 3-27.				      		            (Expected time: 45 min)

Note
You can also download the CADCIM project from www.cadcim.com by following the path: 
Textbooks > CAD/CAM > Plant 3D > AutoCAD Plant 3D 2016 for Designers.

Figure 3-26  Model for Tutorial 1
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Figure 3-27  Dimensions for the model

	 Footing Dimensions:

	 Length= 24 inch
	 Width  = 24 inch
	 Depth  = 24 inch	

The following steps are required to complete this tutorial:

a.	 Open a new Plant 3D drawing file in the current project.
b.	 Create a grid by specifying the axis, row, and platform values.
c.	 Add footings at the bottom of the grid.
d.	 Add columns and beams to the model.
e.	 Cut members at intersections.

Opening a New Plant 3D File
1.	 Double-click on the AutoCAD Plant 3D 2016 - English icon from the desktop of your 

computer to start AutoCAD Plant 3D 2016.

	 Next, you need to create a new AutoCAD Plant 3D file.

2.	 Select the CADCIM project that you have created in Tutorial 1 of Chapter 2 from the Current 
Project drop-down list in the PROJECT MANAGER.

3.	 Select the Plant 3D Drawings node in the Project area and choose the New Drawing button; 
the New DWG dialog box is displayed.

4.	 Enter Pipe_rack.dwg in the File name edit box and choose OK; the new file is created.
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5.	 Select the 3D Piping option from the Workspace drop-down list located in the Quick Access 
Toolbar.

 Creating Grid
1. 	 Choose the Grid tool from the Parts panel in the Structure tab; the Create Grid 

dialog box is displayed. 

2.	 In this dialog box, specify the parameters as given below and retain the default settings for 
other parameters.

	
	 Axis value: 0, 25’, 50’				    Row value: 0, 10’
	 Platform value: 0, 10’, 15’

3.	 Next, choose the Create button from the dialog box; the grid is created, as shown in 
Figure 3-28. Note that the view orientation in the figure is set to SW Isometric. You can set 
the view orientation to SW Isometric by selecting the SW Isometric option from the 3D 
Navigation drop-down list in the View panel of the Structure tab.

Creating Footings
1.	 Choose the Footing Settings tool from the Settings drop-down in the Parts panel; the 

Footing Settings dialog box is displayed. 

2.	 Enter 24 in the Length(1), Width(2), and Depth(3) edit boxes. Next, accept the default 
values in the Material area and choose OK; the settings of the footings are changed and 
the Footing Settings dialog box is closed.

3.	 Choose the Footing tool from the Parts panel; you are prompted to select the insertion 
point. Place all the footings at the bottom grid points, as shown in Figure 3-29.

Figure 3-28  Model after creating the grid Figure 3-29  Model after adding footings

Creating Columns and Beams
To create structural members, first you need to set the properties of the member. Also, you need 
to turn on the object snap and 3D object snap in order to make the selection of grid point easier. 
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1.	 Choose the Member Settings tool from the Settings drop-down in the Parts panel; the 
Member Settings dialog box is displayed.

2.	 Select W and W 10x12 from the Shape type and Shape size list boxes, respectively. Next, 
accept the default values of the other options and choose OK; the settings of the structural 
member are changed and the Member Settings dialog box is closed.

3.	 Choose the Member tool from the Parts panel;

Figure 3-30  Selecting the start point and the 
endpoint of the column

you are prompted to select the start point of 
the member. 

	 Make sure that the Ortho Mode is turned on 
in the Status Bar. 

4.	 Select the grid point, as shown in Figure 3-30; 
you are prompted to select the endpoint. 

5.	 Move the cursor vertically upward and snap to 
the grid point, refer to Figure 3-30. Next, click 
to select it; the column is created between the 
two selected points. Similarly, place columns 
on other footings, as shown in Figure 3-31. You can also use the Copy command to create 
rest of the columns.

	 Next, you need to add beams. But before that, you need to change the justification of the 
member to top.

6.	 Choose the Member Settings tool from the Settings drop-down in the Parts panel; the 
Member Settings dialog box is displayed.

7.	 In the Member Settings dialog box, choose the top center justification point in the 
Orientation window. Next, choose OK to close the dialog box.

8.	 Invoke the Member tool; you are prompted to select the start point. Select the start point 
and the end point, as shown in Figure 3-32; a beam is created between the two selected 
points and a rubber-band line is displayed between the cursor and the specified point. Also, 
you are prompted to select the end point of the new member. Similarly, create rest of the 
beams, as shown in Figure 3-33.
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Figure 3-31  Model after creating columns Figure 3-32  The start point and end point of the 
beam

Note
You can hide the columns such that only the grid points are visible while specifying the start and 
endpoints of the beam.

9.	 Similarly, create the second level. The model after placing all the beams is shown in 
Figure 3-34.

Tip You can select all the beams at the first level and then use the COPY command to create 
the second level. 

Figure 3-33  Model after creating the lower 
level

Figure 3-34  Model after adding two levels 
of beams 

	 Next, you need to cut intersections between members.

10.	 Choose the Cut Back Member tool from the Cutting panel; you are prompted to select the 
limiting member.
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11.	 Select the first column on the left side of the grid; you are prompted to select the structural 
member to be cut. 

12.	 Select any one of the beam that is intersecting with the column; the beam is cut at the 
intersection. Also, you are prompted to select the limiting member. Similarly, cut beams at 
the intersections by using columns as the limiting members.

Saving the Model
1.	 Choose the Save tool from the Quick Access Toolbar; the file is saved. 

2.	 Choose Application Button > Close to close the file.

Tutorial 2
In this tutorial, you will open the CADCIM project created in Chapter 2 and then create a new 
AutoCAD Plant 3D file. In this file, you will create a structural model, as shown in Figure 3-35. 
The layout uses W10x12 structural members. The dimensions of the model are shown in 
Figure 3-36.							                  (Expected time: 45 min) 

Note
You can also download the CADCIM project file of tutorial of Chapter 2 from www.cadcim.com by 
following the path: Textbooks > CAD/CAM >Plant 3D > AutoCAD Plant 3D 2016 for Designers.

Figure 3-35  Structural model for Tutorial 2



Creating Structures				                                  3-23

E
va

lu
a

ti
on

 C
op

y.
 D

o 
no

t 
re

pr
od

uc
e.

 F
or

 i
nf

or
m

a
ti

on
 v

is
it

 w
w

w
.c

a
dc

im
.c

om

Figure 3-36  Dimensions of the model

The other specifications of the model to be created are as follows:
 
	 Grating Specifications

	 Material standard 		  ASTM
	 Material code 		  A242
	 Thickness 			   1”
	 Hatch pattern 		  ZIGZAG
	 Hatch scale	 		  10”
	 Justification 		  Bottom
	 Shape 			   New rectangular

	 Footing Dimensions:

	 Length= 12 inch
	 Width  = 12 inch
	 Depth  = 12 inch

	 Railing Specifications

	 Handrail Height 		  40 inch
	 1st mid rail height 		  20 inch
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	 2nd mid rail height	 	 0
	 Kick plate height 		  5 inch
	 First post 			   10 inch
	 Second post 		  5 feet
	 Handrail Shape 		  PIPE2STD
	 Kick plate Shape		  FB 1/4x4
	 Post Shape			   PIPE2STD

	 Stair Specifications

	 Stair width	  		  60 inch
	 Maximum tread distance 	 10 inch
	 Tread shape 		  36x12x7
	 Stair Shape	 		  C15x50

The following steps are required to complete this tutorial:

a.	 Open a new Plant 3D drawing file in the current project.
b.	 Create a grid by specifying the axis, row, and platform values.
c.	 Add footings at the bottom of the grid.
d.	 Add columns and beams to the model.
e.	 Cut members at intersections.
f.	 Add stairs to the model.
g.	 Create platforms by using the Plate tool.
h.	 Add railings to stairs and platforms.

Opening a New Plant 3D File
1.	 Double-click on the AutoCAD Plant 3D 2016 - English icon from the desktop of your 

computer to start AutoCAD Plant 3D 2016. 

	 Next, you need to create a new AutoCAD Plant 3D file. 

2.	 Select the CADCIM project that you created in Chapter 2 from the Current Project 
drop-down list in the PROJECT MANAGER. 

3.	 Select the Plant 3D Drawings node in the Project area and choose the New Drawing button 
available; the New DWG dialog box is displayed. 

4.	 Enter c03tut02.dwg in the File name edit box and choose OK; the new file is created.   

Creating the Grid
1.	 Choose the Grid tool from the Parts panel in the Structure tab; the Create Grid dialog box 

is displayed.  

2.	 In this dialog box, specify the values, as shown in Figure 3-37. 
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Figure 3-37 Values specified in the Create Grid dialog box

3.	 Next, accept default values for other options and choose the Create button; the grid is 
created. Next, change the view orientation to SW Isometric, refer to Figure 3-38.

Creating Footings
1.	 Choose the Footing Settings tool from the Settings drop-down in the Parts panel; the 

Footing Settings dialog box is displayed.

2.	 In the Footing Settings dialog box, specify the following values: 

	 Length(1): 1’ 			   Width(2): 1’  		  Depth(3): 1’  

	 Next, accept the default values in the Material area and choose OK to close the dialog box. 

3.	 Invoke the Footing tool and place the footings at the bottom grid points, as shown in 
Figure 3-39.  

Figure 3-38  Model after creating the 
grid

Figure 3-39  Model after adding 
footings

Creating Columns and Beams
To create structural members, first you need to set the properties of the member and then place 
a member. Also, you need to turn on the object snap and 3D object snap so that you can easily 
select the grid points. 
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1.	 Choose the Member Settings tool from the Settings drop-down in the Parts panel; the 
Member Settings dialog box is displayed.

2.	 In the Member Settings dialog box, select W and W 10x12 from the Shape type and 
Shape size edit boxes, respectively. Next, choose the middle center justification point in the 
Orientation window and accept default values of the other options. Choose OK; the settings 
of the structural member are changed and the Member Settings dialog box is closed.

3.	 Choose the Member tool from the Parts panel and then place columns on all the footings, 
as shown in Figure 3-40. Use grid points for the precise placement of the columns. 

	 Next, you need to add beams. But before that, you need to change the justification of the 
member to top.

4.	 Invoke the Member Settings dialog box and choose the top center justification point in the 
Orientation window. Next, choose OK to close the dialog box.

5.	 Choose the Member tool and place beams on both levels of the grid. The model after placing 
all the beams is shown in Figure 3-41.

Figure 3-40  Model after adding columns Figure 3-41  Model after adding all beams

 

6.	 Trim the intersections between the members.

Creating Stairs
Next, you need to add stairs to the model. To do so, first you need to set the stair settings and 
then place stairs.

1.	 Choose the Stair Settings tool from the Settings drop-down in the Parts panel; the Stair 
Settings dialog box is displayed.

2.	 Enter 5’ in the Stair width(1) edit box and 10” in the Maximum tread distance(2) edit box. 
Next, specify the Step data and Stair shape as given in the Stair Specification. 

3.	 Choose the browse button located next to the Step data edit box; the Select Step dialog 
box is displayed. Next, choose US Standards and 36x12x7 from the Tread standard and 
Tread shape areas, respectively and then choose the OK button.
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4.	 Choose the browse button given next to the Stair shape edit box; the Select Stair Shape 
dialog box is displayed. Now, select C and C15x50 from the Shape type and Shape size list 
boxes, respectively and then choose the Select button. Next, choose the OK button to close 
the Stair Settings dialog box.

	 Next, you need to create stairs. Make sure that the Object Snap and the 3D Object Snap 
are turned ON.

5.	 Choose the Stairs tool from the Parts panel; you are prompted to select the first point of 
the stair. 

6.	 Change the view orientation of the model to NW Isometric, and select the midpoint on the 
top edge of the member, as shown in Figure 3-42; you are prompted to select the second 
point.

7.	 Select the midpoint at the bottom grid line, as shown in Figure 3-43; a line is placed between 
the two specified points. Press ENTER to create the stairs on the specified line, as shown in 
Figure 3-44.

Figure 3-42  Selecting midpoint on the 
top edge

Figure 3-43  Selecting midpoint at the 
bottom grid line

Adding Gratings
You need to create platforms by adding gratings. 

1.	 Choose the Plate tool from the Parts panel; the Create Plate/Grate dialog box is displayed. 

2.	 Specify the parameters for the grating as given below and then choose the Create button; 
you are prompted to specify the first corner of the grate.

	 Type 			   Grating 
	 Material standard 		  ASTM
	 Material code 		  A242
	 Thickness 			   1”
	 Hatch pattern 		  ZIGZAG
	 Hatch scale 			  10”
	 Justification 		  Bottom
	 Shape 			   New rectangular
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Figure 3-44  Model after creating stairs

3.	 Change the view orientation of the model to SW Isometric and select the corner points, 
as shown in Figure 3-45; a rectangular grating is created on the platform, as shown in 
Figure 3-46.  

Figure 3-45  Selecting corner points to 
create a grating

Figure 3-46  Grating created on the 
model

Adding Railing 
Next, you need to add railing to the stairs and the platforms.

1.	 Choose the Railing Settings tool from the Settings drop-down list; the Railing Settings 
dialog box is displayed. Next, specify settings as given in the Railing Specifications at the 
start of this tutorial.

2.	 Choose the Railing tool from the Parts panel; you are prompted to select the start point of 
the railing. Enter Object at the Command prompt; you are prompted to select an object to 
align the railing. 
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3.	 Select the stairs; a railing is added to the stairs, as shown in Figure 3-47. Note that the view 
orientation in the figure is set to NW Isometric.

	 Next, you need to add railing to the beams.

4.	 Invoke the Railing tool again and select the points, as shown in Figure 3-48; a railing is 
created between the selected points. Next, press ENTER.

Figure 3-47  Railing added to the stairs Figure 3-48  Points to be selected to create 
the railing

5.	 Invoke the Railing tool again and select the start and end points, as shown in Figure 3-49. 
The model after adding the railing is shown in the Figure 3-50.

Figure 3-49  Points to be selected to create 
the railing

Figure 3-50  Model after adding the 
railing

Saving the Model
1.	 Choose the Save tool from the Quick Access Toolbar; the file is saved.

2.	 Choose Application Button > Close to close the file.
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 Self-Evaluation Test 
Answer the following questions and then compare them to those given at the end of this 
chapter:

1.	 In the __________ mode, the members are represented as lines with a shape symbol.

2.	 The __________ mode gives a 3D look to the members with fillets added to the structural 
outline.

 
3.	 You can add a railing to a structural member or a stair by invoking the __________ option 

and selecting them directly.

4.	 The __________ allows you to exchange steel structure data between two applications.

5.	 You need to specify __________ to place a ladder at some distance from the specified location.

6.	 The __________ option creates a miter joint with a gap between the edges. 

7.	 You need to select the __________ check box in the Ladder Settings dialog box to create a 
ladder with a cage.

8.	 You can use the __________ button to match the properties of an already existing member 
with a new member.

9.	 You can modify individual elements of a stair, railing, or a ladder after exploding them. 
(T/F)

10.	 You can convert a line into a structural member by invoking the Member tool and then 
selecting it. (T/F)

 Review Questions 
Answer the following questions:

1.	 The __________ check box in the Railing Settings dialog box is selected to make the middle 
rail continuous.

2.	 The __________ are used to increase or decrease the width of the stairs.

3.	 You can hide all the components except the selected one by using the __________ button.

4.	 You can select an existing polyline to convert it into a grating or a plate if the __________ 
radio button is selected in the Create Plate/Grate dialog box.

5.	 The __________ check box in the Member Settings dialog box is used to orient the Y axis 
in the opposite direction.
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 Exercise 

Exercise 1								         Skid
In this exercise, you will create the model shown in Figure 3-51. Its orthographic views are given 
in the drawing shown in Figure 3-52. The layout uses W10 x12 structural members. 
								                  (Expected time: 30 min)

Figure 3-51  The model for Exercise 1

	 Railing Specifications

	 Handrail Height 		  40 inch
	 1st mid rail height 		  20 inch
	 2nd mid rail height	 	 0
	 Kick plate height 		  5 inch
	 First post 			   10 inch
	 Second post 		  5 inch
	 Handrail Shape 		  PIPE2STD
	 Kick plate Shape		  FB 1/4x4
	 Post Shape			   PIPE2STD

	 Ladder Specifications

	 Width 			   25 inch
	 Exit width	  		  35 inch
	 Projection 			   45 inch
	 Rung Distance 		  10 inch
	 Ladder shape 		  PIPE2STD
	 Rung Shape 		  PIPE3/4STD
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Figure 3-52  Orthographic views for Exercise 1

Answers to Self-Evaluation Test
1. Line Model, 2. Shape Model, 3. Object, 4. Advance Steel XML Export, 5. Directional 
distance, 6. Gap, 7. Draw cage, 8. Match Properties, 9. T, 10. T


